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Introduction
TimeSlice Lite is Shareware - you may try the program for a short time, but if you like it and want to 
keep using it, please send in the requested $25 registration fee.    A lot of time and effort went into 
developing this program, please be fair and help support it.
Please read this manual.    It is short and easy to read.
Feel free to submit comments, suggestions, and bug reports.
TimeSlice® Lite developed by

Maui Software
189 Auoli Drive
Makawao, Maui, HI 96768-9313
Phone: 808-573-0011
FAX: 808-572-2406
email: info@mauisoftware.com
http://www.mauisoftware.com
©Copyright 1995, 1996 Maui Software.
All Rights Reserved Worldwide.

Credits
TimeSlice Lite graphics (startup window, and about box) by

Ed Fenner
Design Mine
Boulder, CO
303.530.4365 / 800.779.2433
email: DesignMine@AOL.COM

TimeSlice Lite program and user's manual icon graphics by
Halvor Nome
NOME A/S Design & Market Communication
Karl Johansgt. 20
N-1776 Halden.
email: nome@oslonett.no

And thanks to all the people who helped beta test TimeSlice Lite.



Install TimeSlice Lite
Installation Instructions for TimeSlice Lite version 2.0.0 for Windows

1. Create a directory for the TimeSlice Lite files.
2. Place the TimeSlice Lite ZIP file in this directory.
3. Use PKZIP to separate (unzip) the ZIP file into individual files into this directory.

16 bit version files are:
TimeSL.exe, 
Datatbl.dll, 
Picscc.dll, 
File_id.diz, 
TimeSL.hlp, 
Readme.txt, 
Install.txt,
MS_ORDER.html,
MS_ORDER.pdf

32 bit version files are:
TimeSL.exe, 
Dtbl32.dll, 
Pics32.dll, 
File_id.diz, 
TimeSL.hlp, 
Readme.txt, 
Install.txt,
MS_ORDER.html,
MS_ORDER.pdf

(If you do not have a PKUNZIP program, download the PKWARE ZIP utility from the web page:     
http://www.pkware.com      )

4. Execute the TimeSL.exe file to use TimeSlice Lite
5. The two DLL files from the ZIP file must be in the directory where TimeSL.exe is executed.

(or if you know what you are doing, the DLL's can be put in a directory where your system can 
find them).
16 bit version DLL's are Datatbl.dll and Picscc.dll
32 bit version DLL's are Dtbl32.dll and Pics32.dll



New Features in this Version
New features for version 2.0.0

International Format Date, Time and Currency values available in the 32 bit version of TimeSlice 
Lite. (uses Regional Settings)
Print entire Notes field on a subsequent line(s) with a Print option.
Edit Time Information in the Time Table Cell as well as in the Edit Time Dialog Box.
Easy method to Add Time Information manually.
Select All / Select None - rows in the Time Table by clicking on the upper left corner of the Time 
Table.
Time Table sizes larger when the Document window sizes larger.
Tool Tips appear when the cursor passes over the Toolbar buttons in the 32 bit version of 
TimeSlice Lite.
Scroll bars appear in the TimeSlice Lite application and document windows when needed.
The Stop Date and Pause Time columns are added to the Time Table and the Printed report.
The Active Time Record has an bold font in the Time Table.
Sizable Columns in the Time Table.
The Edit Time Entry Button pops up the Edit Time Dialog Box with the last row or Active Time 
Record when the Document window is compacted.

New features for version 1.2.0
16 and 32 bit versions of the program (Windows 3.1, 95 and NT versions).
Printed Report has a total line at the end.
February can have 29 days.
Select All, Select None Menu - select all or no rows in the Time Table.
Tile Vertical and Horizontal Menu - tile TimeSlice Lite Document Windows 
Toolbar on the Child Window
New Compact Window feature (screen space saver) to compact each child window separately.
Initial Focus in the Notes edit area in the Edit Time Entry Dialog box.

New features for version 1.1.0
Cut, Copy, Paste, Clear    - time entries (rows) in the table.
Copy, Cut - will also copy the highlighted time entries tab delimited to the clipboard.
Can edit the active time entry
Icon on the icon bar to toggle the Compress/Restore Child Window Menu
Preference setting for Time Display.    For instance, display in one second, one minute 6 minute, 
15 minute increments.    Can also select time displayed in decimal notation, i.e.: two hours and 18
minutes displayed in decimal notation in 6 minute increments is displayed as 02.30

Features for version 1.0.0
Start/Stop and Pause/Resume button
Multi-Document Interface
Print / Print Preview Time Events report
Export time events to tab delimited file
Extensive online help - MS Help format
Automatic Charge calculation
Automatic Document total charge and total time calculation
Default Hourly Rate Preference setting
Hourly Rate set per document
Application Window compacting option for minimal screen usage



Software License Agreement
Please read this agreement thoroughly.
You may use the Registered TimeSlice Lite program on one computer system at one time only. 
If you wish to use the TimeSlice Lite program on more than one computer system at one time, you must 
purchase a new and separate License from Maui Software for each additional computer system (each 
user must purchase their own copy).
For example, you can place the registered TimeSlice Lite program on your office computer and also your
home computer.    However, if you are using a registered copy of TimeSlice Lite on your office computer, 
and someone else is using a registered copy on your home computer, you must purchase two copies of 
TimeSlice Lite because two copies of TimeSlice Lite are being used at the same time.      If you have any 
questions, please contact Maui Software.
You may not give the registered TimeSlice Lite program to other people.
You may not reverse engineer, disassemble, reverse translate, or in any manner decode the TimeSlice 
Lite program in order to derive any source code form.
COPYRIGHTS, TRADEMARK NOTICES, LEGENDS AND LOGOS. The TimeSlice Lite program and 
User Documentation, logos, product, names and other support materials, if any, are either patented, 
copyrighted, trademarked, or otherwise proprietary to Maui Software. You agree never to remove any 
such notices and product identification.
In no event will Maui Software be liable to you for any damages, including any lost profits, lost savings or
other incidental or consequential damages arising out of the use or inability to use this program and user
documentation.    In addition, Maui Software will not be liable for any claim by you or any other party for 
damages arising out of the use of this program.



How To Order TimeSlice Lite
TimeSlice Lite is available for only $25 per copy (one copy per user).    Quantity discounts 
are available.    Contact Maui Software for more information.    Normally you receive your 
registration name and code within 24 hours.    Slow turnaround times occur during 
Christmas, holidays, vacation time, and directly after we release a new version.
There are three order forms you can fill out and send to Maui Software to order our 
software.    One order form is an order form you can fill out that is part of the TimeSlice Lite
program.    A second order form is a HTML file that can be filled out in your browser and 
emailed to Maui Software.    And a third order form is an Adobe Acrobat Document that can 
be filled out and faxed or mailed to Maui Software.    Below, each of the order forms is 
explained.

I. TimeSlice Lite program Order Form.
Use this method to enter in order information and email, fax or postal mail your order.
Here's how to receive your TimeSlice Lite registration code:    

1. Start TimeSlice Lite.    
2. On the introduction dialog box, click on the "Fill Out Order Form" button or click on 

the "Fill Out Order Form" button from the About box. (click on Help menu and then 
About menu to pop up the about box)

3. Fill out all the necessary information.
4. You can email, fax, or postal mail your order.

For fastest service -- pay by credit card and email your order:
a. From the Order Form dialog box, click on the "Save" button and save the order

form to disk.
b. Start your bulletin board program (AOL, CompuServe, etc.), and open the 

order form you just saved (select Open from the File menu to do this).
c. Make any necessary changes, add any comments, and then send it to our 

Internet address.    
For fast service -- pay by credit card and FAX your order:

a. From the Order Form dialog box, click on the "Print" button and print the order 
form.

b. Sign the form, make any necessary changes, add any comments, and FAX it to
us. (a fax cover sheet is not necessary)

For not as fast service -- use the post office:
a. From the Order Form dialog box, click on the "Print" button and print the order 

form.
b. Sign the form if you are paying by credit card, make any necessary changes, 

add any comments, enclose payment, and mail it to us. 

II. Maui Software HTML browser Order Form
Use the MS_ORDER.html browser order form if you want to email your order to Maui 
Software.    Here's how to use the HTML order form.    You can order any of the Maui 
Software products from this order form.    The MS_ORDER.html file is one of the files in the 
TimeSlice Lite ZIP file.    You can also access this same html page from a link in our web 
page:    www.mauisoftware.com

1. Open the MS_ORDER.html file from your hard disk in your Internet Browser program.   
(Netscape, Mosaic, Internet Explorer, etc).    

2. Fill out the information in the form (MS_ORDER.html) in your browser.



3. Connect your computer to the Internet.
4. Click on the button: "Submit" which is towards the bottom of the form.    The 

information filled into the form is then sent in an email message to Maui Software.    
Maui Software will process your order and email the registration code to you.

III. Maui Software Adobe Acrobat Order Form
Use the MS_ORDER.pdf Adobe Acrobat Order form if you want to print and then fax or 
postal mail your order to Maui Software.    You can order any of the Maui Software products 
from this order form.    You must have the Adobe Acrobat Reader v3.0 and above to use this
order method.    The MS_ORDER.pdf file is one of the files in the TimeSlice Lite ZIP file.    You
can also access this same pdf file from a link in our web page:    www.mauisoftware.com    .  
You can download a free copy of Adobe Acrobat Reader from the WWW page:    
www.adobe.com

1. Open the MS_ORDER.pdf file from your hard disk in the Adobe Acrobat Reader 
program.

2. Fill out the information in the form in the Adobe Acrobat Reader program.
3. Print the information in the form (MS_ORDER.pdf) to your printer by clicking on the 

"Print" button at the bottom of the MS_ORDER.pdf form.
4. Fax or postal mail this printed order form to Maui Software.    Maui Software will 

process your order and email, fax or postal mail the registration code to you.

NOTES: 
Shipping a disk with the latest version.    If also you want a TimeSlice Lite diskette mailed to
you (for example, you want to receive the latest version on diskette), please enclose an 
additional $5 to cover postage and handling.    You could make out two checks (the second 
one for $5), and if there is no later version, we will return your $5 check.    Likewise for 
credit card sales.    You can authorize us to charge an additional $5 for shipping a disk if 
there is a later version.    If there is no later version, we won't charge the additional $5.    
This is at your option, and there will be no additional $5 charge unless you specify it.    
You cannot send files (attachments) to our Internet address from non-Internet services 
(although that may change in the future with some on-line services).    That's why you must
send your order form to us as an email message, and not as an attached file.    



How To Register TimeSlice Lite
Once you have received your name and registration code, you can register your copy of 
TimeSlice Lite.    Entering in your name and registration code changes TimeSlice Lite from a 
demo version to a full working version registered to you.
To register TimeSlice Lite with your registration code:

1. Start TimeSlice Lite.
2. The Demo Version Introduction dialog box will be displayed.    Click on the "Register 

Now" button.    The Register TimeSlice Lite dialog box will be displayed.
3. Enter your Registration Name and Registration Code exactly as given to you by Maui 

Software.
4. Click on the "Register" button.    If you receive an error, verify that the name and code

you entered is exactly as Maui Software gave to you.
NOTE:    Your name and registration code is entered in the "TimeSL.ini" file automatically.    
The "TimeSL.ini" file resides in the Windows directory.    If the registration information in this
file is changed or corrupted, the TimeSlice Lite program reverts back to demo mode.    Keep 
your Name and Registration code that Maui Software gave to you in a safe place in case 
you will need to enter the registration information again.



File Menu

The File Menu contains commands to create a new document, open an existing document 
and save an open document to a disk file.    The commands to export the document 
information into a tab delimited file, print a report of the information in the document, and 
exit the TimeSlice Lite program are also available under the File Menu.
New

Use this command to create a new document in TimeSlice Lite.    A new document 
window will be opened.    The 'Ctrl N' key sequence can be used to create a new 
document also.    See Start a New Document for more information.

Open...
Use this command to open an existing document in a new window.    The 'Ctrl O' key 
sequence can be used to open an existing document also.    See Open an Existing 
Document for more information.

Close
Use this command to close the window containing the active document.    TimeSlice Lite 
prompts you to save the document if it has unsaved changes.    Before closing an 
unnamed document, TimeSlice Lite displays the Save As dialog box and suggests that 
you name and save the document.

Save
Use this command to save the active document with its current name and location.    
When you save a document for the first time, TimeSlice Lite displays the Save As dialog 
box so you can name your document.    If you want to change the name or location of an 
existing document, choose the Save As command.    The 'Ctrl S' key sequence can be 
used to save the active document also.    See Save a Document for more information.

Save As...
Use this command to save and name the active document.

Export...



Use this command to save the time entries of the active document to a tab delimited file.
The 'Ctrl E' key sequence can be used to Export the active document also.    See Export a 
Document for more information.

Print...
Use this command to print document reports.    The 'Ctrl P' key sequence can be used to 
Print the active document also.    See Print a Report for more information.    The Print 
preference can be set in the Document Preferences dialog box.

Print Preview
Use this command to switch the active document to and from print preview, with which 
you can see how the document report will look when you print it.    See Print a Report for 
more information.

Print Setup...
Use this command to select a printer and a printer connection.    The printer selected will 
be the printer designated as the selected printer when printing a report.

1, 2, 3, 4
Use the numbers and filenames listed at the bottom of the File menu to open the last 
four documents you closed.    Choose the number that corresponds with the document 
you want to open.

Exit
Use this command to end the TimeSlice Lite program.    TimeSlice Lite prompts you to 
save documents with unsaved changes.



Edit Menu

The Edit Menu contains the commands to Cut, Copy, Paste, Delete, Select All, and Select 
None.    The Cut and Copy commands will copy the highlighted rows from the Time Table to 
an internal buffer.    The buffer internal to TimeSlice Lite will exist until the TimeSlice Lite 
program is exited.    The Cut and Copy commands will also copy the highlighted rows to the 
Clipboard as tab delimited text.    This text is the same format of tab delimited text that is 
saved to a file using the Export feature.    The Select All and Select None command will 
highlight or UN-highlight all rows in the Time Table
Cut

The Cut command will delete the highlighted rows from the Time Table.    A copy of the 
highlighted rows information will be saved in an internal TimeSlice Lite buffer.    This 
internal buffer will allow the user to paste the information into a TimeSlice Lite document
at a later time.    The highlighted rows information will also be saved as "tab" delimited 
text in the Clipboard.    This text is the same format of tab delimited text that is saved to 
a file using the Export feature.    The 'Ctrl X' key sequence can be used to initiate the Cut 
command.    The Cut command can also be activated by selecting the Cut Button from 
the TimeSlice Lite application Toolbar.

Copy
The Copy command will save a copy of the highlighted rows in the Time Table.    The 
highlighted rows will be copied as "tab" delimited text to the Clipboard.    This text is the 
same format of tab delimited text that is saved to a file using the Export feature.    An 
internal TimeSlice Lite buffer will also hold a copy of the information in the highlighted 
rows.    This information held in the internal buffer will then available to be "Pasted" in the
Time Table.    This internal TimeSlice Lite buffer is cleared when the TimeSlice Lite 
program "Exits".    The 'Ctrl C' key sequence can be used to initiate the Copy command.    
The Copy command can also be activated by selecting the Copy Button from the 
TimeSlice Lite application Toolbar.

Paste
The Paste command will copy the internal TimeSlice Lite buffer into the Time Table.    If 
one row is selected, the rows will be added before the selected row.    Otherwise, the new 
rows will be added to the end of the Table, but before an active Time Entry row.    Only 
highlighted rows that have been previously Cut or Copied from within TimeSlice Lite can 
be Pasted.    The 'Ctrl V' key sequence can be used to initiate the Paste command.    The 
Paste command can also be activated by selecting the Paste Button from the TimeSlice 
Lite application Toolbar.

Delete
The Delete command will delete the highlighted rows from the Time Table.    The rows 
deleted will NOT be put in the Clipboard or saved to the internal TimeSlice Lite buffer.    
Pressing the 'Delete' key can be used to initiate the Delete command.    The Delete 
command can also be activated by selecting the Delete Button from the TimeSlice Lite 
Document Window Toolbar.



Select All
The Select All command will highlight all rows in the Time Table.    The 'Ctrl A' key 
sequence can be used to initiate the Select All command.    The Select All and Select 
None commands can be toggled by clicking on the upper left corner of the Time Table.

Select None
The Select None command will UN-highlight all rows in the Time Table.    The Select All 
and Select None commands can be toggled by clicking on the upper left corner of the 
Time Table.



Time Menu

The Time Menu contains commands to edit a time entry, edit a time table cell, add a time 
entry, to set Document Preferences for the active document and to set General TimeSlice 
Lite program preferences.

Edit Time Entry...
Use this command to display the Edit Time Entry dialog box.    The Time Table row(s) that 
is highlighted in the active document will be available for editing in this dialog box.    The 
Edit Time Entry command can also be activated by selecting the Edit Time Button from 
the TimeSlice Lite Document Window Toolbar.

Edit Time Table Cell                F2
Use this command to initiate the Edit of the selected Time Table Cell.    Pressing the 'F2' 
key will also initiate the Edit of the selected Time Table Cell.    The time table cell that has
the dashed "input" highlight in the Time Table in the active document will be put into edit
mode.    The Edit Time Table Cell command can also be activated by selecting the Edit 
Time Table Cell Button from the TimeSlice Lite Document Window Toolbar.    See Edit Time
Entry for more information on editing time information in the Table Cell.

Add Time Entry                Ins
Use this command to manually add Time Records to the Time Table.    Pressing the 'Insert'
key will also initiate the Addition of a record to the Time Table.    See Manually Add Time 
Entry for more information on manually adding time information in the Time Table.

Document Preferences...
Use this command to display the Document Preferences dialog box.    The preferences 
specific to the active document can be set here.    The document specific preferences 
include the hourly rate, time display options and print options.    The Document 
Preferences command can also be activated by selecting the Document Preferences 
Button from the TimeSlice Lite Document Window Toolbar.

General Preferences...
Use this command to display the General Preferences dialog box.    The auto-save, default
hourly rate and window compacting options can be set here.    The TimeSlice Lite General
Preferences command can also be activated by selecting the General Preferences Button 
from the TimeSlice Lite Document Window Toolbar.



View Menu

You can display or hide parts of the screen to achieve the balance you want between 
graphical features and the size of the area this application uses on the screen.
Toolbar

Use this command to display and hide the Toolbar, which includes buttons for some of 
the most common commands in TimeSlice Lite, including New, Open, Save, Cut, Copy, 
Paste, Print, Compact/Restore and Help.    A check mark appears next to the command 
name when the Toolbar is displayed.

Status Bar
Use this command to display and hide the Status Bar.    The Status Bar will display a 
description of selected menus and buttons.    A check mark appears next to the command
name when the Status Bar is displayed.



Window Menu

The Window Menu contains commands to manipulate the child window within the TimeSlice
Lite program window.    The Cascade, Tile - Horizontal, Tile - Vertical, Arrange Icons, 1,2,3,4, 
are standard Multi-Document Interface commands.    The Compact Windows and Restore 
Windows commands are specific to the TimeSlice Lite program.
Cascade

This command arranges TimeSlice Lite document windows so that they overlap.    The 
title bar of each window remains visible, making it easy for you to select any window.

Tile - Horizontal
This command arranges TimeSlice Lite document windows one above the other, so that 
each window is visible and none overlap.

Tile - Vertical
This command arranges TimeSlice Lite document windows side by side, so that each 
window is visible and none overlap.

Arrange Icons
This command will arrange TimeSlice Lite document windows that are reduced to icons, 
so that you can see them all.

Compact Windows
This command will minimize the TimeSlice Lite document windows, arrange them in the 
upper left portion of the TimeSlice Lite application window, and resize the TimeSlice Lite 
application window to contain one row of document icons.    See Compact Screen Usage 
for more information.

Restore Windows
This command will restore the TimeSlice Lite application window to the size and location 
when the Compact Windows command was executed.    See Compact Screen Usage for 
more information.

1, 2, 3, 4 
This command will make an opened TimeSlice Lite document window active when you 
choose its name from this list.    All open TimeSlice Lite document windows are listed, 
including those that have been reduced to icons.



Help Menu

Help Contents
Use this command to display the opening screen of TimeSlice Lite in the Windows Help 
application.    From the opening screen, you can jump to specific instructions for using 
TimeSlice Lite and to various types of reference information.    The Help command can be
activated by selecting the Help Button from the TimeSlice Lite Document Window 
Toolbar.    The Help command can also be activated by selecting the Help Button from the
TimeSlice Lite application Toolbar.

About TimeSlice Lite
Use this command to display the version number of this copy of TimeSlice Lite for 
Windows.    The copyright notice and the person who this copy of TimeSlice Lite is 
registered to is also displayed.



Set Hourly Rate
You can change the hourly rate for each specific document.    You can also change the 
default hourly rate that each new document will use.
Change Hourly Rate for a Specific Document
You change the hourly rate of the active document in the Set Hourly Rate dialog box.    The 
Set Hourly Rate dialog box is displayed by clicking the SET button on each document.    The 
hourly rate can be changed by selecting the Document Preferences... menu which is under 
the Time Menu.    The hourly rate can also be changed by selecting the Document 
Preferences Button from the TimeSlice Lite Document Window Toolbar.    Type in the new 
hourly rate in the edit box and click on the OK button to change the hourly rate on the 
document specified.
NOTE:    All of the time charges for the active document will be recalculated using this new 
hourly rate.
Change Default Hourly Rate for New Documents
You change the default hourly rate for new documents in the General Preferences dialog 
box.    The General Preferences dialog box is displayed by selecting the General Preferences
menu from under the Time menu.    The General Preferences dialog box can also be 
displayed by selecting the General Preferences Button from the TimeSlice Lite Document 
Window Toolbar.

Enter the hourly rate in the preferences dialog box to change the default hourly rate for new 
documents.



Auto Save Feature
The Auto-Save feature of TimeSlice Lite will save the contents of a document every set 
number of minutes.    The Auto-Save feature is set in the General Preferences dialog box.    
The General Preferences dialog box is displayed by selecting the General Preferences menu
from under the Time menu.    The General Preferences dialog box can also be displayed by 
selecting the General Preferences Button from the TimeSlice Lite Document Window 
Toolbar.

The auto-save feature is enabled when the Auto-Save check box is checked.    In the Minutes 
box, type how often (in minutes) you want TimeSlice Lite to save your work.    
NOTE:    The Auto-Save feature will not save a NEW document until a name has been given 
to the document.



Start a New Document
You can start a new document by selecting the New Menu from under the File Menu.    The 
'Ctrl N' key sequence can be used to create a new document.    You can also select the New 
button from the Toolbar to start a New document.    An empty document window inside the 
TimeSlice Lite program window will be opened when a new document is started.



Open an Existing Document
There are many ways to open a TimeSlice Lite document or an earlier version document 
file.    Some of the following descriptions are specific on whether you are running the 
Windows 3.1 type of "Program Manager" user interface or the Windows 95 "Start Button" 
user interface.    So, look for the descriptions specific to the type of Windows Interface you 
are using.
Use the File-Open Menu or Open Toolbar Button
You can open an existing document by selecting the Open Menu from under the File Menu.   
The 'Ctrl O' key sequence can be used to open an existing document.    You can also select 
the Open button from the Toolbar to open an existing document.    The standard File-Open 
dialog box will be displayed to help you specify which file you want to open.    A document 
window with the requested file is displayed inside the TimeSlice Lite program window when 
the file is opened.
Drop a TimeSlice Lite Document Icon onto a TimeSlice Lite Program

(Windows 95 and Windows NT 4.0)
TimeSlice Lite will start and open a TimeSlice Lite document when a TimeSlice Lite 
document is dropped on the TimeSlice Lite program icon.    One way to organize your files, 
is to create shortcuts to the TimeSlice Lite program and documents on your desktop.    Then
drag the first document and drop it on the TimeSlice Lite program shortcut to start 
TimeSlice Lite.    Then drop any other TimeSlice Lite documents on the running TimeSlice 
Lite program to open each subsequent document.    See the Windows online help for more 
information on creating shortcuts.
Drop a TimeSlice Lite Document Icon onto a TimeSlice Lite Program

(Windows 3.1 and Windows NT 3.5)
TimeSlice Lite will start and open a TimeSlice Lite document when a document file is 
dropped on the TimeSlice Lite icon in the Program Manager.    Open the Program Manager 
group that has your TimeSlice Lite Program icon in it.    Open the File Manager so you can 
see your TimeSlice Lite documents.    Arrange the Program Manager and File Manager so 
you can drag the document from the File Manager and drop it on the TimeSlice Lite icon in 
the Program Manager.
Double Clicking on a TimeSlice Lite Document Icon

(Windows 95 and Windows NT 4.0)
Double clicking on a TimeSlice Lite document icon will start up the TimeSlice Lite program 
with that document opened.    The TimeSlice Lite document icon or shortcut to the 
TimeSlice Lite document can be activated.    The TimeSlice Lite document icon can be in the
Explorer, on the Desktop or in the Start Menu.
Double Clicking on a TimeSlice Lite Document Icon

(Windows 3.1 and Windows NT 3.5)
In the File Manager, find the TimeSlice Lite File to be opened in TimeSlice Lite.    Double click
on the TimeSlice Lite document file.    The TimeSlice Lite Program will be started with the 
selected TimeSlice Lite document opened.    You may need to create an association between
the TimeSlice Lite Program and the files with a '.tt' extension.    See the Windows online 
help for more information on creating associations between a Program and a file extension.
Using the Properties Page of a Shortcut to TimeSlice Lite Program Icon

(Windows 95 and Windows NT 4.0)
A Shortcut to the TimeSlice Lite Program can be set up to automatically open a specific 
TimeSlice Lite document when the Shortcut Icon is activated.



First, a TimeSlice Lite shortcut icon must be created.    To create a shortcut, select the 
TimeSlice Lite Program file in Explorer.    Drag the TimeSlice Lite Program file to the Desktop
or the Start Menu directory in your Windows directory to create the shortcut.
Second, edit the Property Page of the shortcut to TimeSlice Lite icon.    To pop-up the 
Property Page, select the shortcut icon and click on the right mouse button and select the 
Property menu.    In the Property page, click on the 'Shortcut' tab.    In the 'Target:' edit area,
the name of the TimeSlice Lite program path is specified.    In the 'Target:' edit area, add a 
space after the TimeSlice Lite program path and then type in the name of the TimeSlice 
Lite document file including the pathname.    Then click on the OK button.
Using the Program Manager TimeSlice Lite Program Icon

(Windows 3.1 and Windows NT 3.5)
A TimeSlice Lite Program icon can be set up in the Program Manager to automatically open 
a specific TimeSlice Lite document when this TimeSlice Lite Program icon is activated.    In 
the Program Manager TimeSlice Lite icon, edit the properties.    Add the name of the 
TimeSlice Lite document name after the TimeSlice Lite program filename.    See the 
Windows online help for more information on Program manager icons.



Save a Document
You can save an open document by selecting the Save or Save As Menu from under the File 
Menu.    The 'Ctrl S' key sequence can be used to save the active document.    You can also 
select the Save button from the Toolbar to save an open document.    The standard Save As 
dialog box is displayed when the Save As Menu is selected or the document being saved 
has not been assigned a file name.    Use the Save As dialog box to help you specify the 
name of the file to save the documents data into.



Print a Report
You can print a report containing the time entry information of a document.    You print a 
report by selecting the Print Menu from under the File Menu.    The 'Ctrl P' key sequence can
be used to Print the active document.    You can select the Print button from the TimeSlice 
Lite application Toolbar to print the active document or select the Print Button from the 
TimeSlice Lite Document Window Toolbar. The active document's information will be printed
in the report.    The standard Print dialog box is displayed to aid in specifying printer 
information.    
You can preview the printed report by selecting the Print Preview Menu from under the File 
Menu.
Print option for Notes Column:
The option to print the notes on the same line as the other fields in a time entry or on the 
subsequent line(s) is available in the Document Preferences Dialog Box.    If the notes are to
be printed on the same line as the other fields, only the portion of the notes that fill to the 
end of the line will be printed.    If the notes are to be printed on the subsequent lines, the 
notes will start printing on the line after the other fields in the record and will continue on 
subsequent lines until all of the notes are printed for that time entry.    See Document 
Preferences dialog box for more information.
Print a Custom Report
A custom report utilizing the TimeSlice Lite time data can be created using a Spreadsheet 
or Database program.    Export the TimeSlice Lite data or copy the contents of the TimeSlice
Lite document to the clipboard.    Import the TimeSlice Lite data or Paste the TimeSlice Lite 
data from the clipboard into the Spreadsheet or Database program.    Then define a report 
in the Spreadsheet or Database program and print the Custom TimeSlice Lite report from 
the Spreadsheet of Database program.    See Export a Document for more information.



Export a Document
The Export command is located under the File Menu.    The 'Ctrl E' key sequence can be 
used to Export the active document.    The Export button is located in the Document 
Window Toolbar.    Use this Export menu or button to save the time entries of the active 
document to a tab delimited file.    This tab delimited file can then be imported into almost 
every database, spreadsheet, and work processing program.    You can use these other 
programs to make customized reports, or import the TimeSlice Lite exported data in a 
database or financial program for further processing.
The Export As dialog box is displayed when the Export menu or Export button is selected.    
The Export As dialog box is similar to the Save As dialog box.    Specify a file name in the 
dialog box and click on the OK button to save the active documents information in this file.  
The default file extension for exported data is '.txt'.
The Cut and Copy features will place the highlighted time entry records as tab delimited 
text in the Clipboard.    The time entry records tab delimited data is the same format that is 
saved to a file with the Export feature.    You can then paste this tab delimited text into a 
database or reporting program to format output for reports.



Time an Activity
START Timing
You time an activity by selecting the Start Button on a document or the Start menu on the 
documents control menu.    
PAUSE / RESUME Timing
You can pause and resume the timing of an activity by selecting the Pause Button or 
Resume Button on the document or the Pause Menu or Resume Menu on the documents 
control menu.    
STOP Timing
You can stop the timing of an activity on a document by selecting the Stop Button on a 
document or the Stop menu on the documents control menu.

The Start/Stop menu text toggles between the label of Start and Stop.    The Pause/Resume 
menu text toggles between the label of Pause and Resume.    The Start / Stop, and Pause / 
Resume buttons are located on the Document Window Toolbar.



Compact Screen Usage
Two menu commands, two buttons on the toolbars and some preferences are available to 
resize the TimeSlice Lite windows.    These commands are available to have the TimeSlice 
Lite program rearrange its windows quickly to take up the least amount of space on your 
screen.
There are two ways to minimize the size of the TimeSlice Lite windows.    One way is to 
minimize all child Document windows at once.    The other way is to shrink the size of child 
Document windows individually.
Shrink Child Document Windows Individually

To Shrink or Restore the size of the child windows individually, click on the Compact/Restore
Button located on the Document Window Toolbar.    With the TimeSlice Lite windows 
compacted, you can start, stop, pause and resume timing of your work and restore the size 
of the child window using the buttons on the Document Window Toolbar.    The Active Time 
Entry row or last row can be edited while the Document Window is compacted by clicking 
on the Edit Time Button on the Document Window Toolbar.

Minimize All Child Document Windows

With the TimeSlice Lite windows compacted, you can start, stop, pause and resume timing of
your work using the system menu of each iconized document window.    You popup the 
system menu for an icon by clicking on the document icon once.
Compact and Restore Menus
The two menus Compact and Restore. are located under the Window Menu.    

Compact Windows Menu    This command will minimize the TimeSlice Lite document 
windows, arrange them in the upper left portion of the TimeSlice Lite application window,
and resize the TimeSlice Lite application window to contain one row of document icons.
Restore Windows Menu    This command will restore the TimeSlice Lite application 
window to the size and location when the Compact Windows command was executed.

Compact / Restore Application Toolbar Icon



This Compact / Restore Icon is located in the TimeSlice Lite application Toolbar.    The Child 
Windows can be compacted or restored to original locations by clicking on this icon.
Compacting Preferences
You can set preferences for the compacting of the TimeSlice Lite windows in the General 
Preferences dialog box.    The General Preferences dialog box is displayed by selecting the 
General Preferences Menu from under the Time Menu.    The General Preferences dialog box
can also be displayed by selecting the General Preferences Button from the TimeSlice Lite 
Document Window Toolbar.

The two settings you can control for the compacting of the TimeSlice Lite windows are 
whether the status bar or toolbar will automatically be hidden when the Compact Menu is 
selected.    These two settings can be changed in the General Preferences dialog box.



Display Time Feature
The Elapsed Time can be displayed in various formats and increments of time.    The 
Elapsed Time is displayed in the Elapsed Time area by the top of the document window, the
elapsed time column in the Time Table and the Total Elapsed time by the top of the 
document window.    
The Elapsed Time Display preferences can be selected in the Set Document Preferences 
Dialog Box.    The time display preferences can be changed by selecting the Document 
Preferences... menu which is under the Time Menu.    The time display preferences can also 
be changed by selecting the Document Preferences Button from the TimeSlice Lite 
Document Window Toolbar.    See Set Document Preferences Dialog Box for more 
information on setting the time display preferences.

Time Display Increments
The exact number of seconds elapsed is saved for a time entry record.    The manner in 
which the time is rounded up and displayed on the screen or in reports is affected by the 
selections described here.    The Elapsed time can be displayed in increments of 1 second, 1
minute, 6 minutes, 15 minutes and 100th of an hour.    An example of how the time: one 
hour, 12 minutes and 34 seconds will be displayed in each.

1 second    The elapsed time is displayed down to the second.    This is the only selection
where the seconds are displayed.    The example time is displayed as:    01:12:34
1 minute    The elapsed time is displayed only in hours and minutes.    Any seconds will 
round up to the next minute.    The example time is displayed as:    01:13
6 minutes    The elapsed time is displayed in hours and minutes where the minutes are 
multiples of 6.    The minutes are rounded up to the next multiple of 6.    The example 
time is displayed as:    01:18 in the default format of hours : minutes and the time is 
displayed as:    01.30 in the decimal format.
15 minutes    The elapsed time is displayed in hours and minutes where the minutes are
multiples of 15.    The minutes are rounded up to the next multiple of 15.    The example 
time is displayed as:    01:15 in the default format of hours : minutes and the time is 
displayed as:    01.25 in the decimal format.
100th of an hour    In this time increment display, you select the number of 100th of an 
hour increments to display the elapsed time in.    The number entered in the text box can 
range from 5 - 100.    This number is only used when the 100th of an hour is selected.    
For instance, enter the number 50 to have the time displayed in increments of 30 
minutes (i.e.: 50/100 hour or 1/2 hour).    Another instance, enter the number 10 to have 
the time displayed in increments of 6 minutes (i.e.: 10/100 hour or 1/10 hour).    Another 
instance, enter the number 5 to have the time displayed in increments of 3 minutes (i.e.:
5/100 hour or 1/20 hour).    If the number 50 is entered in the text box, the example time 
is displayed as:    01:30 in the default format of hours : minutes and the time is displayed 
as:    01.50 in the decimal format.

Time Format
Default Format    The default format to display the time in is:



        hour : minute    or    hour : minute : second
Decimal Format    Time can also be displayed decimally in hours and hundredths of an 
hour.    For instance, using time display of 6 minute increments, one hour and 12 minutes 
will be displayed regularly as:    01:12 and in decimal notation the time would be 
displayed as:    01.20
Decimal format is not available for time display increments of 1 second and 1 minute.



Edit Time Entry
You can edit the information in any of the rows in the Time Table two ways.    You can edit 
each of the items in the Time Table right in the cell.    You edit a row of Time Entry 
information in the Edit Time Entry dialog box.    You can edit any Time Entry Row.    Editing 
the Start Date, Start Time, Paused Time and Notes of an Active Time Record is valid.    
Editing the Stop Date and Stop Time for an Active Time Record is not valid since the timer 
will change the Stop Date and Time until the timer is stopped for that record.
Edit Time Information in the Cell
The Time Entry Information can be edited on the main Document Window right in the cell in
the table.    The Date and Time values will show the format set in the Date and Time 
Settings in your Windows Control Panel.
Select a Cell to Edit:    To edit a cell in the Table, click on the cell to select the cell you 
want to edit.
Begin Edit Mode:    Then put the cell into edit mode.    The cell can be put into edit mode 4
ways:    press the "F2" key, select the Edit Time Table Cell menu, select the Edit Time Table 
Cell Button or just start typing and the contents of the cell will be overwritten.
Edit the Cell:    The "Start Date" and "Stop Date" cells expect input to be in a Date format 
as selected in the Regional Settings of your computer.    The "Stop Time" and "Stop Time" 
expect input to be in a Time format as selected in the Regional Settings of your computer.    
The "Paused Time" expects input to be in a 24 hour Time Format.    The Paused Time format 
is hours : minutes or hours : minutes : seconds.    The "Notes" cell will expand to show 3 
lines of text while in edit mode and revert back to show the first line when not in edit mode.
The text area will automatically scroll vertically.    The Notes text is limited to 255 characters
per cell.    You can insert line feeds into the notes area by entering a "CTRL-ENTER" key 
combination.    You can move up and down in the lines of Notes during edit by using the 
"UP" and "DOWN" arrow keys.    The "Elapsed Time" and "Charge" cells are NOT editable.
End Edit Mode:    To end the edit of a cell, press the "Enter", "Return", "Tab", or "Shift-Tab" 
key, or click on a different cell.    If there is any error in the changes made to the value of 
the cell, the previous value will be displayed in the cell.
Edit Time Information in the Edit Time Entry Dialog Box
A Time Table row can be edited in the Edit Time Entry dialog box.    In the Edit Time Entry 
dialog box, you can edit a couple fields of the record before the changes are made back to 
the row in the Time Table.    See Edit Time Entry dialog box for more information on editing 
the time entry records in the edit time entry dialog box.



Manually Add Time Information
You can add Time Information manually by selecting the Add Time Entry Menu from under 
the Time Menu.    The 'Insert' key can also be used to insert a time record into the active 
document.    The Time Entry row will be inserted as the last row in the Time Table, or the 
second last row if there is an active timer for the last row.    The time record that is inserted 
will have the current date and time as the start date, start time, stop date, and stop time.    
The elapsed and paused time will be zero.    You can then edit the time record to contain the
applicable time information.    The time information can be edited in the cells on the main 
screen or in the edit time dialog box.    See the Edit Time Entry section for more information 
on editing the Time Entries.



International Date, Time, Currency Customization
You must be using the 32 bit version of TimeSlice Lite to take advantage of the currency 
part of this feature.    Both the 16 and 32 bit versions of TimeSlice Lite will display the date 
and time in the International setting selected on your computer.
TimeSlice Lite will display the Date, Time and Currency as set in the Windows Control Panel 
- Regional Settings.    Chances are that you will not have to do anything special to your 
computer for the TimeSlice Lite 32bit version to display the date, time and currency using 
your Regional Settings.    See the Windows online help - Regional Settings for more 
information.
Changing Regional Settings
Use the Windows Control Panel to select the Regional Setting for your computer.    Select 
the Regional Setting for your locale.    Then allow your computer to reboot to have this 
change in Regional Setting take affect.    After you select a Regional Setting, you can further
customize how you want the date, time and currency to be displayed.    If you need more 
explanation on how to customize a date, time or currency, while in the Regional Settings, 
click the '?' button in the upper right corner of the Regional Settings dialog box and then 
click on the area of the dialog box that you want more information about.
Be careful when changing the date, time and currency settings in the Regional Settings by 
text editing the values.    Any customization will be reflected in all the software running on 
your computer and how the software will display dates, times and currencies.    So, if you 
make a mistake in your text editing of these settings, these mistakes will be reflected 
consistently across your computer system and software which utilizes the Regional 
Settings.



Document System Menu
This is the documents System Menu.    It contains the usual document system menus, plus a
start/stop menu and pause/resume menu that mirror the start/stop and pause/resume 
buttons on the document.



Program Minimize / Maximize Buttons
The Programs Minimize and Maximize buttons will act on the entire TimeSlice Lite program 
window.    The Minimize button will reduce the TimeSlice Lite to an icon.    The Maximize 
button will make the TimeSlice Lite program window as big as your screen can handle.



Program Title Bar
The TimeSlice Lite Programs Title Bar will display the TimeSlice Lite program name and the 
name of the active document window.



Program System Menu
The TimeSlice Lite Programs System Menu is the standard program system menu.



Menu Bar
The TimeSlice Lite Program Menu Bar contains the standard File, Edit, View, Window and 
Help Menus.    For more information about the menus click on Menu Commands and the 
Help Table of Contents will be displayed with a list of menu commands to click on.    



Status Bar
The TimeSlice Lite Status Bar contains the standard help messages for Menu selections.



Application Tool Bar
The TimeSlice Lite Program Tool Bar contains shortcut buttons to execute the standard File-
New, File-Open, File-Save, Edit-Cut, Edit-Copy, Edit-Paste, File-Print and Compact/Restore 
Child-Windows and Help commands.



Document Tool Bar
The Document Tool Bar contains shortcut buttons to execute the following commands:    

 Compact/Restore Child-Windows,

    Start    

 Stop Timing,

 Pause    

 Resume Timing,

 Edit Time Entry Row(s),

 Print,

 Export,

 Edit General Preferences,

 Edit Document Preferences,

 Delete Time Entry Row(s),

 Edit Time Table Cell and

 Help.



Document Minimize / Maximize Buttons
The document Minimize and Maximize buttons will control that documents window size.    
The Minimize button will reduce the document window to an icon at the bottom of the 
TimeSlice Lite window.    The Maximize button will make the document window as big as will
fit inside of the TimeSlice Lite program window.



Document Title Bar
Every TimeSlice Lite document window has a title bar that displays the name of the file that
holds that documents information.



Notes
This column holds some notes about this time entry.    The notes are entered or changed in 
the cell or in the Edit Time Entry dialog box.



Charge
This column displays the amount of charge calculated for the duration in this time entry.    
The charge is calculated by multiplying the Elapsed Time by the Hourly Rate.



Paused Time
This column holds the paused time for the time entry.    The time is expressed in the hours, 
minutes and optionally seconds paused.    The time is displayed in the format selected in 
the Control Panel - Regional Settings.



Elapsed Time
This column holds the elapsed time for the time entry.    The time can be displayed in 
increments of seconds, minutes, 6 minute, 15 minute and 100th of an hour intervals.



Stop Time
This column holds the time that the time entry was stopped.    The time is displayed in the 
format selected in the Control Panel - Regional Settings.



Start Time
This column holds the time that the time entry was started.    The time is displayed in the 
format selected in the Control Panel - Regional Settings.



Stop Date
This column holds the stop date that the time entry was stopped.    The date is displayed in 
the format selected in the Control Panel - Regional Settings.



Start Date
This column holds the start date that the time entry was started.    The date is displayed in 
the format selected in the Control Panel - Regional Settings.



Time Table
This Table contains rows of Time Entry information.    Each row contains the start and stop 
time with the paused and elapsed time, charge and notes.



Total Charge
The Total Charge is shown in the Grand Totals box at the top of the document window.    This
total is the sum of all of the 'Charge' cells of every row in this document.



Pause / Resume Button
The Pause / Resume button will pause or resume the timer for the current active time entry. 
Clicking on the Pause button will pause the timer for the current active time entry.    Clicking
on the Resume button will resume the timer for the current active time entry.



Hourly Rate
The hourly rate displayed here is the hourly rate used by this document.    Every document 
window can have a different rate.    All of the time entries of a document will use this rate to
calculate the Charge.    You can change the hourly rate used by this document by clicking 
on the Set button.



Total Elapsed Time
The Total Elapsed Time is shown in the Grand Totals box at the top of the document window.
This total is the sum of all of the elapsed time cells of every row in this document.



Start / Stop Button
The Start / Stop button will start or stop the timer.    Clicking on the Start button will start 
the timer and show a new time entry row in the Time Table.    Clicking on the Stop button 
will stop the timer on the active time entry row in the Time Table.    The Active Time row is 
shown in bold font.



Elapsed Time
The Elapsed window shows the time of the active time row.    The time can be displayed in 
increments of seconds, minutes, 6 minute, 15 minute and 100th of an hour intervals.



Active Time Row
The Active Time Row is displayed in bold font.    The Active Row is also the last row in the 
Time Table.



Select All / Select None Button
This button in the upper left corner of the Time Table will toggle to Select All Rows in the 
Time Table and then UnSelect the Rows in the Time Table.



Select Row Button
The buttons in the left side of the Time Table will toggle to select a rows in the Time Table 
and then unselect the row in the Time Table.    Each of these buttons will control the 
selection of the row it is on.



TimeSlice Lite Main Window
TimeSlice Lite Main Window is the usual Windows Multi-Document Application.    The Main 
Window has a title bar, menu bar, tool bar, status bar.    The TimeSlice Lite can have 
multiple files open.    Each file will be opened in its own child window which always resides 
inside of the TimeSlice Lite application.    The following bitmap has 'hot spots' on it so that 
you can click on an area of the bitmap to popup a window of more information about a 
particular area of the TimeSlice Lite window.

The prompts for the toolbar buttons appear in the status bar when a button is depressed.    
The prompts for the toolbar buttons can be shown and the toolbar buttons not executed if 
the cursor is moved off the toolbar button before the mouse button is released.    In the 32 
bit version of TimeSlice Lite, the Tool Tips and status bar prompts will be displayed when the 
mouse moves over the Toolbar Buttons.



Set Hourly Rate Dialog Box
Use this dialog box to change the hourly rate for an individual document.    This dialog box 
can be displayed by selecting the SET button in a document window.    The hourly rate can 
be changed by selecting the Document Preferences... menu which is under the Time Menu. 
The hourly rate can also be changed by selecting the Document Preferences Button from 
the TimeSlice Lite Document Window Toolbar.

Document Name    The name of the document that will receive this change in hourly rate 
is displayed in the dialog.    In the above example, the document name is TimeT1.
Hourly Rate    Enter the new hourly rate to be used in the specified document.
Select the OK button to change the hourly rate on the document.    Select the Cancel 
button to leave the hourly rate unchanged.



Set Document Preferences Dialog Box
The Document Preferences Dialog Box is displayed by selecting the Document Preferences 
menu under the Time menu.    The Document Preferences Dialog Box can also be displayed 
by selecting the Document Preferences Button from the TimeSlice Lite Document Window 
Toolbar.    The active documents Hourly Rate and Time Display feature settings can be 
altered using this dialog box.

Name of the Active Document    The name of the active document is displayed at the 
top of this dialog box.    The changes made in this dialog box will apply only to this 
document.
Active Document Hourly Rate Preference    Enter the hourly rate here to change the 
hourly rate for the active document.    The hourly rate entered will be used to calculate the 
Total Charges for this document.    The hourly rate entered here will be displayed in the 
"Hourly Rate" box at the bottom of the active document.
Active Document Time Display Preference    Select the time increment to display the 
elapsed time of the active document.    The elapsed time can be displayed in increments of 
seconds, minutes, or multiples of 6 minutes, 15 minutes or hundredths of an hour.    The 
time increments of 6 and 15 minute intervals, and hundredths of an hour can be displayed 
in Hour : Minute or in decimal notation.    The "use decimal notation" is grayed out when 1 
minute or 1 second intervals are selected.    The edit box next to the "100th of an hour" is 
grayed out when "100th of an hour" is not selected.    See the Time Display Feature for 
more information.
Print Preference    Check the box to have the notes start printing on the line following the 
other fields of the time entry.    If the notes are to be printed on the same line as the other 
fields, only the portion of the notes that fill to the end of the line will be printed.    If the 
notes are to be printed on the subsequent lines, the notes will start printing on the line 
after the other fields in the record and will continue on subsequent lines until all of the 
notes are printed for that time entry.
Select the OK button to save any changes in the preferences.    Select the Cancel button to
disregard any changes in the preferences.



Set General Preferences Dialog Box
The General Preferences Dialog Box is displayed by selecting the General Preferences menu
under the Time menu.    The General Preferences dialog box can also be displayed by 
selecting the General Preferences Button from the TimeSlice Lite Document Window 
Toolbar.    The Auto-Save feature, default hourly rate, and compacting settings can be 
altered using this dialog box.

Auto Save Preference    The auto-save feature is enabled when the Auto-Save check box 
is checked.    In the Minutes box, type how often (in minutes) you want TimeSlice Lite to 
save your work.    
Default Hourly Rate Preference    Enter the hourly rate in the preferences dialog box to 
change the default hourly rate for new documents.
Compact Windows Preference    The two settings you can control for the compacting of 
the TimeSlice Lite windows are whether the status bar or toolbar will automatically be 
hidden when the Compact Menu is selected.    The x'd status bar check box means that the 
status bar will be hidden when the Compact Menu is selected.    The x'd Tool Bar check box 
means that the Tool Bar will be hidden when the Compact Menu is selected.
Select the OK button to save any changes in the preferences.    Select the Cancel button to
disregard any changes in the preferences.



Edit Time Entry Dialog Box
The Edit Time Entry dialog box provides the mechanism to edit the information in any of 
the rows in the Time Table.
There are several ways to bring up the Edit Time Entry dialog box with a row of time 
information to edit.    Double click on a time entry row to bring up the Edit Time Entry dialog
box with the selected row of information in it.    You can edit time entry records by selecting 
one or more rows in the Time Table and then select the Edit Time Entry menu under the 
Time Menu.    The Edit Time Entry command can also be activated by selecting the Edit 
Time Button from the TimeSlice Lite Document Window Toolbar.    When the Document 
Window is compacted, the last row or Active Time Entry row can be edited by clicking on 
the Edit Time Button on the Document Window Toolbar.

In the Edit Time Entry dialog box, you can edit the Start Date, Start Time, Stop Date, Stop 
Time or Pause Time.    Then click on the Recalculate button to see the new Elapsed Time 
calculated.    You cannot edit the Elapsed Time directly.    Type in comments information in 
the Notes edit window.
Tips on editing the Start and Stop Date and Start and Stop Time areas in this 
dialog.    The Start and Stop Date and Start and Stop Time areas can be edited by double 
clicking the digit area (i.e. month, day, year, hour, minute, etc.) you want to change and 
then using the up and down arrow keys to increase or decrease the numeric value.    The 
Date and Time separators (i.e.: ':' or '/') cannot be edited.    The Date and Time digits can be
selected and changed.    You can place your text cursor before a digit and just type a 
number to replace the digit after the cursor.    The Date and Time edit areas will not allow 
an invalid digit to be entered.    For instance, if you want to edit the minute digits and place 
your cursor before the tens digit of a minute value and type '"67", the value of "57" will be 
entered because the minutes ten digit max. is '5'.
Start Date and Time    The Start Date and Time specifies the beginning of a time period.    
The Date and Time format follow the settings in the Control Panel.    If you make changes to 
the Start Date or Time and want to see the changes reflected in the Elapsed Time, click on 
the Recalculate button.
Stop Date and Time    The Stop Date and Time specifies the end of a time period.    The 
Date and Time format follow the settings in the Control Panel.    If you make changes to the 
Stop Date and want to see the changes reflected in the Elapsed Time, click on the 
Recalculate button.    Making changes to the Stop Date and Time of an Active Time Record 
will not be saved since an Active Time Record has not stopped yet.
Paused Time    The Paused Time specifies the total amount of time to exclude from 
between the Start and Stop Date.    This time is originally generated by the total 



accumulated time the Pause button has been selected.    If you make changes to the Paused
Time and want to see the changes reflected in the Elapsed Time, click on the Recalculate 
button.    The "Paused Time" expects input to be in a 24 hour Time Format of hours and 
minutes and optionally seconds.
Elapsed Time    The Elapsed Time is the total amount of time between the Start and Stop 
Time, but subtracting out the Paused Time.    The Elapsed Time is displayed as selected in 
the Time Display settings of the document preferences.    The Elapsed Time is calculated 
when the Recalculate button or the OK button is selected.
Notes    A textual note can be added to each time period row.    The total number of 
characters allowed in the note is 255.    The accumulated number of characters entered in 
the Note edit box is shown under the Notes.    The Notes edit box will automatically wrap 
the text.    You can enter 'Carriage Returns' in the Notes edit box to force new lines.
Click on the OK button if you want to transfer this changed information back to the Time 
Table.    If more time entry records were highlighted to be edited, the next record is 
displayed in the dialog box.
Click on the Cancel button to disregard any changes made to the time entry information in 
this dialog box.    If more time entry records were highlighted to be edited, the next record 
is displayed in the dialog box.
Click on the Cancel All button to disregard any changes made to the time entry 
information in this dialog box.    The Edit Time Entry dialog box is dismissed even if more 
time entry records were highlighted to be edited.






















































































